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1
About This Guide

This section provides supporting information for the Oracle Data Foundation Cloud Services for
Banking (DFCS).

Audience

This document contains release information of Oracle Data Foundation Cloud Services for
Banking (DFCS).

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility
Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My
Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Related Resources

• Oracle Financial Services Data Foundation Cloud Service for Banking

Conventions

The following text conventions are used in this document.

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated with an
action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for which
you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code in
examples, text that appears on the screen, or text that you enter.
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2
Introduction to Data Foundation Cloud Service

The Oracle Financial Services Data Foundation Cloud Service (DFCS) for Banking offers a
consistent, efficient, and well-governed data management solution tailored to meet both
internal and regulatory data requirements for banks. It includes a comprehensive data catalog
designed to support key analytical use cases across finance, risk, and compliance domains.
This solution is powered by a feature-rich platform that enables data ingestion, data quality and
reconciliation, hosts high-quality historical data, and facilitates the distribution of validated data
through extraction routines and data visualization tools, such as reports.

Figure 2-1    Data Foundation

Oracle Data Foundation Cloud Service (DFCS) is a cloud-native data management and
processing platform that offers a single source of truth by using a unified and integrated results
area. The platform stages the data directly from the source systems, processes it, and delivers
results for downstream consumption.

Below are the salient features of the DFCS:

• Data Foundation prioritizes consistency in definition of data (and its governance) of a
financial institution by using an industry-leading ontology of business terms to model the
data.

• Data Foundation ensures transparency in data management processes by enforcing
Change Management at its core, leading to safer adaptability (extension) of its
comprehensive pre-built data model (and data catalog).

• Data Foundation provides an extensive Results Area that acts as the metaphorical
single-source-of-truth for all data needs of an organization across key functions, such as,
risk, finance, and compliance.

• Data Foundation also standardizes distribution of data to downstream applications and
use cases by providing certifiable interfaces for consumption.
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2.1 Organization of the User Guide
This user guide is divided into nine chapters. Chapters 2 through 7 focus on the core modules
of the Data Foundation Platform.

1. Getting Started: This chapter outlines the process for ordering and configuring the Data
Foundation Cloud Service.

2. Data Catalog: This chapter details the structure and organization of the Data Catalog,
which outlines the data model for the Data Foundation.

3. Data Controls: This chapter covers the two types of data controls supported by the
service: Data Quality (DQ) and Reconciliation. It describes the structure of prepackaged
DQ rules and provides guidance on configuring and using these rules, along with the new
reconciliation rules.

4. Data Integration: This chapter details the data integration features that support the
sourcing of data into the staging area and the extraction of data from the Data Foundation
for downstream consumption.

5. Data Operations: This chapter details various DFCS tasks that can be combined into a
sequence of data movement activities, including sourcing, curation, and consumption.

6. Data Visualization: This chapter is divided into two main sections:

• Data Browser: As DFCS is a SaaS service, users require a cloud-based data browser
to explore data. This section explains how to browse both source data and results
data.

• Pre-Built Reports and KPIs: DFCS is pre-configured with pre-built reports and KPIs.
This section provides guidance on using these examples for reference and
customization.

7. Change Management: All changes in DFSC are managed through a comprehensive
issue-mechanism. This chapter describes how to capture data events as issues and assign
appropriate actions for resolution to the respective action owners.

8. Key Terms and Concepts: This chapter defines the key terms and concepts used
throughout the User Guide.

9. Support: This chapter describes how to contact Oracle for support and clarification
requests.

Chapter 2
Organization of the User Guide
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3
Getting Started

The Oracle Financial Services Data Foundation Cloud Service (DFCS) for Banking provides a
consistent, efficient, and well-governed data management platform for internal as well as
regulatory/jurisdictional data needs of a bank. It comes with prebuilt data integration pipelines
and a comprehensive data catalog for well-known use cases of a bank.

3.1 Why DFCS?
Consider a bank with a diverse portfolio of products. They aim to accomplish the following two
primary data management objectives.

• Maintain a consistent view of data to meet regulatory obligations and support internal
performance measurement reporting.

• Reduce data sourcing costs by retrieving data once from a book-of-record system and
utilizing it across multiple downstream applications.

Suppose the bank encounters challenges in achieving these objectives:

• The data nomenclature used by regulatory agencies and internal use cases does not align
well with the terminology used in book-of-record systems.

• Each consuming application is developed independently, making it easier to source data
multiple times rather than achieving alignment across all consuming applications.

To address these challenges and achieve their data management objectives, the bank decides
to implement DFCS.

• DFCS offers a unified view of data sourced from book-of-record systems for all commonly
known consumption use cases in a bank. With DFCS, the bank only needs to source data
once, regardless of the number of downstream use cases currently in scope.

• A standardized set of quality-checked and reconciled datasets feeds into downstream
applications, ensuring consistent reporting for both regulatory and internal use cases.

3.2 Product Setup
To get started, you must activate the Data Foundation Cloud Service (DFCS). Refer to Oracle®
Financial Services Data Foundation Cloud Service for Banking Getting Started Guide.

3.3 DFCS User Interface
The Data Foundation Cloud Service (DFCS) application provides a tailored user interface
based on the user's role. The landing page and available menu options are dynamically
adjusted according to the user's assigned group.

1. Business Analyst User – Focused on data exploration and analysis.

2. Data Governance Analyst User – Provides tools for data quality, compliance, and
governance.
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3. Administration User – Manages system configurations, user access, and administrative
tasks.

Each user group sees a customized dashboard and navigation menu, ensuring a role-specific
experience within the application.

3.3.1 User Group Mapping for Landing Page
The landing page configuration is determined by the user’s assigned group:

Table 3-1     User Group Mapping

User Group User Type

• DFBSYSADMN
• DFBAPPADMIN

Administration user

• DFBQLTCNTRL
• DFBRECONADMIN

Data Governance / Data Controls User

DFBCATLGOWN Business Analyst user

3.3.2 DFCS Business Analyst User Interface
The Business Analyst User interface in DFCS is designed to support data exploration and
analysis. It provides tools and functionalities that enable users to access, analyze, and
visualize data efficiently.

3.3.2.1 Data Catalog - Line of Business (LOB)
Upon logging into the DFCS application, a Business Analyst User is presented with a
streamlined interface tailored for efficient data exploration and issue tracking.

Landing Page Components

• Data Catalog View:

– Access Line of Business (LOB) and Subject Area views.

– Ability to view Entities and Ingress Connectors for data exploration.

• Data Browsing & Issue Logging:

– Browse Data with a dropdown option to refine searches in the Subject and Results
area.

– Log Issue directly from the home page for quick issue reporting.

• Task List & Issue Management:

– Displays the top 5 items from Issues & Actions, highlighting overdue tasks.

– Option to Review Issues directly from the home page without navigating to the inbox.

– View Inbox option for a full list of tasks and communications.

Table 3-2    Data Catalog – Line of Business (LOB): Landing Page Components

Menu Option Description

Source / Results Land on the OAS Home page

Log Issue Open Issues and Actions module

Chapter 3
DFCS User Interface
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Table 3-2    (Cont.) Data Catalog – Line of Business (LOB): Landing Page Components

Menu Option Description

Review Open Issues and Actions module

View Issue Open Issues and Actions module

No. of Ingress Connectors Open Ingress connectors, no default filtration
available for now

Number of Entities Open Entities, no default filtration available for now

Note:

The Task List displays only the five most recently updated items from Issues &
Actions, based on the latest available updates.
The View Inbox button below the task list, the Review button for each task item, and
the Log Issue button all redirect to the same page—Issues & Actions—functioning
similarly to an inbox. They do not navigate to any specific issue within Issues &
Actions.

3.3.3 DFCS Data Governance Analyst User Interface
Upon logging into the DFCS application, a Data Governance / Data Control User is
presented with a dashboard displaying key data quality and reconciliation metrics through
sample graphs.

Landing Page Components:

• Data Quality Monitor (DQ Monitor):

– Displays two graphs:

1. Data Error Ratio

2. Number of Records Failed vs. Scanned

– Clicking on the DQ Monitor graph redirects the user to the Data Visualization Report
for DQ Monitor.

– A "Refresh Data" button at the top right corner allows users to update the displayed
data.

• Reconciliation Difference:

– Displays two graphs:

1. Source and Target Balances

2. Negative and Positive Absolute Differences

– Clicking on the Reconciliation Difference graph redirects the user to the Data
Visualization Report for Reconciliation Difference.

– A Refresh Data button at the top right corner allows users to update the displayed
data.

Chapter 3
DFCS User Interface
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Figure 3-1    DFCS Data Governance Analyst User Interface

3.3.4 DFCS Administrator User Interface
Upon logging into the DFCS application, an Administrator User is presented with a Foldout
Menu and a Task List for efficient system management and oversight.

Landing Page Components:

• Foldout Menu:

– Provides access to key administrative functions, including:

1. Data Catalog

2. Data Integration

3. Data Controls

4. Data Visualization

Table 3-3    Landing Page Components

Foldout Menu Item Sub menu options

Data Catalog – Business Terms
– Entities

* Extend Data Catalog

Data Integration – Data Source Templates
– Data Pipelines
– Data Extraction
– Connectors

* Add Data Source Templates
* Add Data Pipelines
* Add Data Extraction

* Add Connectors

Data Controls – Data Quality Check
– Data Quality Group
– Data Quality Exceptions
– Reconciliation Rules

* Add Reconciliation Rule
* Extend Data Quality

Chapter 3
DFCS User Interface
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Table 3-3    (Cont.) Landing Page Components

Foldout Menu Item Sub menu options

Data Visualizations – Source Data Visualization
– Results Data Visualization
– Data Quality Dashboard
– GL Reconciliation Dashboard
– Add New Visualization

* View Sample Reports

Note:

The number displayed beneath the items in the Foldout menu denotes the
cumulative count of items available under that category.

3.4 Setting Up Your Service
This section provides the details on setting up Data Foundation Cloud Service (DFCS).

• Pre-deployment process for the Domain

• Post-deployment process for the Domain

3.4.1 Pre-deployment process for the Domain
The pre-deployment process requires selecting business domains, which determine deployed
data and metadata. Domains can be added later but cannot be removed once deployed. Extra
domains do not impact service usage.

• Domain

3.4.1.1 Domain
Domains represent business segments that you operate. The list of domains available with
your service will be listed for you to choose from. Your choice will determine data and metadata
artefacts that are deployed by the service for your use. You may choose one or more domains
and subsequently revise your choice with additional domains, as needed. You will not,
however, be allowed to drop domains once selected and deployed. Please note that additional
domains, even when chosen in error, will not adversely affect your usage of the service.

3.4.1.1.1 Select your Domain
This section helps you to select the business domain that aligns with your data deployment.
This will tailor the service to instantiate the right data structure for banking-specific needs.

1. In the Choose Domain page, select Banking to deploy.

2. Click Continue.

A confirmation message is displayed.

Chapter 3
Setting Up Your Service
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Note:

• If you click Continue without selecting a domain, a warning message Please
select at least one domain. appears.

• Once you select a domain, the Continue button is enabled.

• By clicking Continue, the deployment process is initiated for the selected
domain.

• The system displays the deployment status, indicating progress and
completion.

3.4.1.1.2 Deploying the Domain
1. On the Deploy Domain page, the deployment steps, and the status of the deployment is

displayed.
The following is the list of steps initiated in the deployment process.

• Deploy Catalog: Deploys a physical instance of data structures based on the selected
Domains.

• Refresh Data Interface: Generates and deploys a logical abstraction layer to support
Data Services, following the specifications in the Catalog.

• Generate Data Quality Checks: Creates and deploys Data Quality assessment
routines as per the specifications in the Data Catalog.

• Deploy Dimension Rules: Deploys Dimensions required by the service, including
Slowly Changing Dimensions (SCDs).

• Reporting Object Registration: Registers reporting objects, enabling them to be
accessed and utilized within the reporting framework.

• Generate Data Connections: Deploys Data Services necessary for facilitating data
movement within the deployed data structures.

• Applying Redaction Policy: Implements data protection by applying redaction rules
to sensitive portions of the Catalog, including Personally Identifiable Information (PII).

• Generate Pipelines: Creates and deploys process definitions in the service’s Process
Management Framework to execute required functional tasks.

• Deploy Application Data Service: Deploys the data service layer required for
application-level interactions with the underlying data structures.

The following is the list of statuses displayed in the deployment process.

• Deployment Status Indicators: Each step is marked with a success, failure, or yet to
start status.

• Deployment Progress: The deployment status will change to Ongoing.

• Verify Deployment Status: Ensure that all deployment statuses are marked as
Completed.

2. Click Start Deployment to initiate the process.

3. Once the deployment is Successful, you will be automatically redirected to the login page.

Chapter 3
Setting Up Your Service

3-6



Note:

• If you are still logged in when the deployment is completed, you will be
redirected directly to the homepage.

• If you log out after triggering the deployment and log back in later, you will be
taken to the homepage.

• If the deployment is still in progress, you will be redirected to the deployment
page displaying the progress.

3.4.2 Post-deployment process for the Domain
After the deployment process is complete, additional steps are required to ensure the domain-
specific configurations are fully functional and optimized.

1. After completing the pre-deployment steps, the admin must configure the following:

a. Legal Entity

b. Fiscal Period

c. Configure Parameters

2. To configure the above steps, navigate to the DFCS URL, and then click the User Menu >
Administration.
The system displays all the required configurations.

3.4.2.1 Legal Entity
The Legal Entity setup is used to define the reporting currency and specify the fiscal period for
posting entries. You can configure one or more Legal Entities for which the service maintains
the Management Ledger and performs related financial tasks.For each Legal Entity, a
Management Ledger is maintained to generate financial reports as part of the reporting
process. The service also supports a hierarchical structure of Legal Entities, enabling the
capture and organization of financial data accordingly.

• Legal Entity Settings

Note:

Maximum levels supported for Legal Entity hierarchy in Balance reconciliation is
5.

3.4.2.1.1 Legal Entity Settings
The Legal Entity Settings allow you to define the reporting currency used for financial
transactions and reporting.

To set up the Reporting Currency, follow these steps:

1. To access Legal Entity Settings, go to the Home page, click Administration, and then
select Legal Entity.

The Legal Entity Settings page is displayed.

Chapter 3
Setting Up Your Service
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2. On the Legal Entity page, all available Legal Entities are listed on the left-hand side. To
configure the Reporting Currency and Fiscal Year for a specific Legal Entity, follow these
steps:

a. Select the required Legal Entity from the list (if available).

b. Set the fiscal period to open for posting entries by disabling or closed for posting
entries by enabling the Locked? option. An open posting period is when the selected
posting period is set to open and the other posting periods stay closed.

c. Set the Reporting Currency to the required standard. This Reporting Currency is
used during the Execution Process in Process Orchestration.

3. Click Save to save the Legal Entity settings.

3.4.2.2 Fiscal Period
The Fiscal Period Setup allows you to define the financial reporting periods for a specific
Legal Entity. It ensures all transactions are recorded within the correct accounting periods,
supporting accurate financial reporting and compliance with fiscal regulations.

• Set Up Fiscal Periods

• Compile Fiscal Periods

3.4.2.2.1 Set Up Fiscal Periods
Using this setup, you can:

• Add a new Fiscal Period to establish reporting timelines.

• Edit an existing Fiscal Period to update details such as start and end dates.
Open or close posting periods to control financial entries.

To add or edit a Fiscal Period, perform the following steps:
During deployment, an Administrator can set up Fiscal Periods using the procedure outlined
below. After deployment, Fiscal Periods can be managed from the Fiscal Period Settings
page. To access this page:

1. To navigate to the Fiscal Period Settings screen, on the Home page, click User Menu >
Administration > Fiscal Period.
The Fiscal Period Settings page is displayed.

Adding Fiscal Period

1. Click the Setup tab, the four built-in Fiscal Year Quarters are displayed: Quarter 1,
Quarter 2, Quarter 3, and Quarter 4.

2. Select the required quarter for a specific Legal Entity before proceeding.

3. Click Add Fiscal Period to add a new row in the Fiscal Periods list.

4. Double-click the Fiscal Period Name to edit and update it.

Note:

The Fiscal Period Name and Quarter Name must contain 50 or lesser characters.

5. Double-click the Start Month field and select the required month (default: January).

6. Double-click the Start Day field and choose the appropriate start day.

Chapter 3
Setting Up Your Service
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7. Similarly, select the End Month and End Day values.

8. Verify these values across all quarters before proceeding.

9. Click Save to save the added fiscal period for the selected quarter.

Editing the Fiscal Period

1. Follow the above steps, and double-click on any of the field to edit the values.

2. Click Save to save the modified changes.

Deleting the Fiscal Period

1. To delete an existing Fiscal Period, click the corresponding Delete icon.
A confirmation message is displayed. Acknowledge the message.

Note:

The Fiscal Periods set up in this Fiscal Period Module are associated with the
Legal Entity. This Fiscal Period Attribute is sourced as a part of the Legal Entity.

3.4.2.2.2 Compile Fiscal Periods
To assign a year or a fiscal year to the fiscal periods of the legal entity, use the Compile Fiscal
Periods process. During deployment, the administrator can set up Compile Fiscal Periods
using this procedure, or, after deployment.

To compile a set of fiscal periods for a year, perform the following steps:

1. To navigate to the Fiscal Period Settings screen, on the Home page, click on User Menu
> Administration > Fiscal Period.

The Fiscal Period Settings page is displayed.

2. Click the Compile tab.

Note:

If the fiscal period added in the setup page does not match with the compile date
range, the system displays an error message Error occured while getting fiscal
periods.

3. Click Start Dateand choose the required start date.

4. Click End Date and choose the required end date.

Note:

Once a start date has been compiled, you cannot load data for earlier dates.
Attempting to do so will result in a data ingestion failure due to partition
restrictions.

5. Click Compile to generate a date dimension and fiscal calendar for the selected date
range.

The selected date range is generated.

Chapter 3
Setting Up Your Service
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3.4.2.3 Configure Parameters
The Parameters are constant-value, run-time, or current-date variables intended for use with
DFCS. Apart from a seeded (predefined) set of System Parameters, you can add, modify, or
remove them as needed.

• Accessing Parameters

• Parameter Settings

• Defining a Parameter

• Modifying and Viewing a Parameter

• Deleting a Parameter

3.4.2.3.1 Accessing Parameters
To access the Parameters window, follow these steps.

1. To navigate to the Parameters screen, on the Home page, click on User Menu >
Administration > Parameters.

The Parameters Summary window is displayed.

2. Use the search option to search for a specific source.

3. Click Add to create a parameter. For more information, see Defining a Parameter section.

3.4.2.3.2 Parameter Settings
This section describes the parameter settings.

Table 3-4    Fields in the Parameters Window

Fields Description

Parameter Name The name for the placeholder that you want to
define. For example, MISDATE, which can be used
as a placeholder for Date.

Parameter Description The description for the parameter you want to
define. Example description: “MISDATE can be
used to substitute the date values for each day,
dynamically, in mmddyyyy format.”

Parameter Type There are three parameter data types:

• Constant is selected for substituting a
constant value.

• RunTimeis selected for substituting a value,
dynamically, in run time. In the example that is
used here, MISDATE can be selected as Run
Time because it is used to make a substitution
dynamically.

• CurrDate is selected for substituting a value
as Current System Date.

Value Applicable only for Constant data types. Holds the
actual value of the parameter.

3.4.2.3.3 Defining a Parameter
To define a new Parameter, follow these steps:

Chapter 3
Setting Up Your Service
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1. Click Add on the Parameters Summary screen.

2. Specify the information as described in the Parameter Settings section Parameter Settings.

3. Click Save.

3.4.2.3.4 Modifying and Viewing a Parameter
You can edit or view an existing parameter.

To edit or view a parameter, follow these steps:

1. Click the required parameter from the Parameters Summary screen.

2. Modify the name, description, type, value, default value or date format.

3. Click Save.

3.4.2.3.5 Deleting a Parameter
To delete an existing parameter, follow these steps:

1. On the Parameters Summary, click Delete corresponding to the parameter you want to
delete.

Confirm your action.

2. Click Yes to delete the Parameter.

Note:

You can not delete parameters in the following cases:

• If the parameter is used by any higher object. Example: Connector/EDD.

• If the parameter is pre-seeded.

Chapter 3
Setting Up Your Service
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4
Data Catalog

Data Foundation organizes metadata for the underlying data model using a shared glossary of
business terms and entities. By sharing business terms across entities, it ensures consistency
in physical data characteristics, such as data types and lengths. It also centralizes data
governance by automatically applying rules, like data quality standards, to any entity that uses
a field mapped to the business model.

For more information, refer to the Oracle® Data Foundation Cloud Service Data Platform
guide.

4.1 Business Terms
The catalog acts as a central repository for Business Terms (BT), ensuring consistent
definitions for business concepts across the platform. It contains over 10,000 business terms
spanning more than 1,500 entities.

Each business term includes key attributes such as:

• Logical Data Type

• Element Type

• Seeded/ Custom Business Terms

• Originating Application

• PII Indicator (identifying if it contains Personally Identifiable Information)

Related business terms share a common definition while maintaining context-specific
relevance for different user roles, ensuring clarity and consistency across the organization.

4.1.1 Business Term Name
The Business Term Name serves as the standardized identifier for a Business Term within
the Data Catalog, ensuring uniformity and clarity across the application. It provides a
concise, human-readable representation that effectively captures the term's purpose and
meaning in a logical and structured format.

Key Characteristics:

• Standardized & Consistent – Ensures uniform terminology across systems.

• Clear & Readable – Designed for both technical and business stakeholders.

• Supports Data Traceability – Facilitates seamless mapping across diverse systems.

For example, a logical name like End of Period Balance clearly conveys its role and
relevance within financial reporting and analysis.

The naming conventions follow best practices, prioritizing clarity, scalability, and alignment
with the associated entity and attributes, ensuring effective communication and governance
across the data ecosystem.
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4.1.2 Business Term Data Type
Data Types provide a framework for classification that defines the nature of data within a
system, ensuring proper interpretation, storage, and manipulation. Each logical data type is
designed for specific use cases, clearly distinguishing how different types of data should be
handled. For instance, types like amount, amount_long, and amount_medium represent
financial figures with varying levels of precision and scale, while currency denotes monetary
values linked to a specific currency. These logical data types help maintain the structure,
integrity, and compatibility of data models across various systems and applications.

Following are some of the Data Types supported in DFCS:

Table 4-1    Mapping of logical data types to Oracle-specific data types

Logical Data Type Oracle Data Type

Amount NUMBER(22,3)
Date DATE
Flag CHAR(1)
Indicator VARCHAR2(1)
Rate_Percent NUMBER(11,6)
Code_Alphanumeric VARCHAR2(20)

4.1.3 Business Term Description
A Business Term Description provides a fundamental explanation of a Business Term, offering
a base definition that remains consistent and relevant across all contexts. It outlines the term's
core purpose and meaning, ensuring clarity and uniformity in its understanding and application.
This description serves as a common reference for stakeholders, connecting technical and
business perspectives while remaining independent of specific implementations or use cases.
For example, End of Period Balance could be defined as the account balance at the end of a
reporting period, reflecting a snapshot of financial standing. By delivering a universal and
context-neutral definition, the Business Term Description promotes clear communication,
traceability, and alignment with business objectives across various systems and processes.

4.1.4 Business Term References
Business Term References represent a comprehensive list of all entities within the data catalog
where a specific Business Term is used or mentioned. This includes the source and result
entities that store, process, or propagate the term, enabling complete traceability within the
data architecture. By documenting these references, stakeholders can track the flow and
usage of the term across various system tables, ensuring consistency and alignment. For
instance, the term End of Period Balance might appear in tables related to financial reporting,
account summaries, and transactional data. These references ensure that all data models
adhere to accurate term definitions and interpretations, promoting data integrity and
consistency.

4.1.5 Related Business Terms
Related Business Terms are variations of a core business term, each adapted to a specific
contextual meaning within different business processes or applications. While they share a
common foundational concept, their interpretation or usage may vary to address distinct
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functional requirements. For example, "Country Code" might refer to a standardized ISO code
for global identification, whereas Regulatory Country could represent a jurisdiction-specific
classification used in compliance or regulatory reporting. Defining related business terms
ensures clarity and precision in data usage, fostering effective communication across diverse
teams and systems. This approach enhances traceability, minimizes ambiguity, and
strengthens data governance by connecting related terms under a unified framework while
accommodating their contextual distinctions.

4.1.6 Business Term Contextual Descriptions
The Contextual Description offers application-specific definitions of a Business Term, tailored to
reflect its unique interpretation and usage within particular systems or domains. It
complements the universal Business Term Description by providing context that aligns with the
functional and technical requirements of each application. For instance, the term End of
Period Balance may refer to a customer's account balance at the close of a financial period in
a core banking application, while in the insurance domain, it could represent the balance
remaining on a policyholder’s account. These tailored definitions ensure clear communication,
promote accurate data usage, and ensure that the term’s meaning aligns with the operational
and analytical needs of each system. By providing targeted descriptions, the Contextual
Description helps bridge potential gaps in understanding and maintains consistency across
diverse applications.

4.1.7 Business Term Data Quality
Data Quality Rules establish the criteria and constraints necessary to ensure the accuracy,
consistency, completeness, and reliability of data associated with a Business Term. These
rules define validation checks, threshold limits, and compliance conditions that data must meet
to maintain its integrity across systems and processes. For example, for the term End of
Period Balance, data quality rules might include ensuring the value is non-negative, matches
the sum of debits and credits for a reporting period, and corresponds correctly to the
associated account type. These rules are applied at both the table and attribute levels in the
data model to detect anomalies, prevent errors, and ensure compliance with regulatory or
business standards. By implementing strong Data Quality Rules, organizations can uphold
data integrity, foster trust in their data assets, and enable accurate decision-making.

4.1.8 Business Term List of Values
The List of Values (LoV) for Business Terms consists of a predefined set of acceptable values
or categories associated with a specific Business Term. These values establish clear
boundaries for data entry, ensuring consistency, standardization, and accuracy across systems
and processes. For example, the Business Term, Account Status might have a List of Values
such as "Active, Inactive, Closed, and Suspended. The LoV is typically managed in lookup
tables within the data model and plays a key role in validation, reporting, and analysis. By
defining and enforcing the List of Values, organizations can reduce errors, simplify data
interpretation, and ensure consistent application of the term across various operational and
analytical contexts.

4.1.9 Business Term Use Case
The Business Term Use Case documents the specific applications of a Business Term across
various systems, illustrating how the term supports distinct business processes and analytical
needs. This mapping ensures that the term’s definition and usage align with the objectives of
each system. For example, the term End of Period Balance might be used in Profitability
applications to calculate income and expense margins, in Asset Liability Management to
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evaluate balance sheet stability, and in Liquidity Risk management to assess cash flow
sufficiency. By outlining these use cases, the Business Term Use Case promotes accurate data
alignment across systems, facilitates seamless integration, and ensures the term is effectively
utilized to achieve both operational and strategic goals.

4.2 Entities
Entity refers to a distinct and logically defined data object that represents a set of data in
banking operations. Entities are used to structure and organize data within a database or data
warehouse and are critical to maintaining consistency, traceability, and clarity in data
management. The entity contains business terms. The granularity of the entity is decided by
Primary Key which can be one or many business terms. The entity will hold the data from
various source systems or data within Data Foundation.

4.2.1 Line of Business
Data Catalog in DFCS provides comprehensive support for data for the following lines of
business.

• Retail and Personal Banking

• Wholesale Banking

• Investment Banking and Wealth Management

• Treasury

• Ancillary Lines of Business

It also has rich coverage for Reference and Market Data that are needed by the lines of
business.

Additionally, it supports a rich dimensional model for storing results for a comprehensive set of
use cases across Finance, Risk, and Compliance domains.

Table 4-2    Line of Business

Category Total No. of Entities

Retail and Personal Banking 48

Wholesale Banking 81

Investment Banking and Wealth
Management

50

Treasury Services 21

Ancillary Lines of Business 23

Reference and Market Data 23

4.2.1.1 Grain Classification
Data Catalog in DFCS provides the grain classification. Each grain can have one or more
entities. Grains represent the smallest, indivisible units of financial data that form the
foundation for processing and analyzing entities. These grains ensure granular-level detail and
traceability across various entities. Examples include entries such as Customer Account, which
identifies individual customer financial details, and Customer Account Transactions, which
record specific financial movements. Date serves as a temporal dimension for tracking
transaction timelines, while Exchange Rates provide currency conversion details essential for
multi-currency operations. General Ledger Data consolidates financial information at the
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account level for reporting and analysis, complemented by Management Ledger for managerial
insights. Other granular elements, such as Group Insurance Policy Beneficiary and Group
Insurance Summary, capture policy-specific details, while Policy Claim, Policy Claim
Transaction, and Policy Commission Transactions detail insurance operations. Finally, Party
Consent represents customer authorization for processing sensitive financial data. These
grains collectively create a robust and detailed framework for accurate and transparent
financial accounting.

Some of the examples for grain counts are Customer Accounts, General Ledger Data.

4.2.1.2 Entity Type Classifications
Entity type classification is a structured method for organizing entities based on their purpose
and functionality within a data catalog. Each entity type plays a distinct role in ensuring
seamless data processing and analysis. In the provided framework, the distribution highlights
the criticality of various classifications:

• Dimension Results: These entities offer contextual and descriptive master data.

• Fact Results: These entities store transactional and quantitative data that serve as the
foundation for performance measurement and reporting.

• Point of Integration: These pivotal entities act as connectors, ensuring the smooth
exchange and alignment of data across different Apps.

• Processing: These entities handle computational logic and business operations,
transforming raw data into actionable insights.

• Staging: The most numerous, these entities store raw or intermediate data, playing a vital
role in validation, enrichment, and data transformation workflows.

This classification ensures each entity is effectively utilized for its specific function, fostering
efficiency and consistency in data-driven processes.

Table 4-3    List of Entity Type

Entity Type Count

Dimension Results 776

Fact Results 554

Point of Integration 3

Processing 9

Staging 1201

4.2.2 Product Processor Entities
The classification of financial products based on their processor categories and catalog entities
is crucial for organizing and managing data within financial systems. This systematic approach
categorizes various financial instruments and contracts across different domains, ensuring
accuracy and consistency. By organizing products into distinct categories such as assets,
derivatives, liabilities, and off-balance sheet assets, this classification helps improve data
accuracy, ensure regulatory compliance, and streamline reporting. Examples of such
classifications include assets like loan contracts, overdraft accounts, and investments;
derivatives like credit derivatives, swaps, and options; liabilities such as term deposits and
borrowings; and off-balance sheet assets like commitments and letters of credit. This
structured framework supports consistent product processing, facilitates seamless integration
across financial systems, and ensures clarity in the representation of financial data.
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Some of the core products of banking are:

• Loan Contracts

• Term Deposits

• Option Contracts

• Letter of Credit

4.2.3 Reference Data Entities
Reference data in a data catalog serves as a foundational component that standardizes and
contextualizes data across systems and processes. It represents relatively static datasets used
to provide consistency, alignment, and meaning in data-driven workflows. Examples of
reference data include Catalog Entity, which organizes and identifies key entities; Currency,
which defines monetary units for financial transactions; and Country, which standardizes
geographical identifiers. Additional reference data like Forecast Exchange Rate provides
predictive currency values essential for planning and analysis, while Macro Economic Variables
and Macro Economic Variable Details capture high-level economic indicators and their granular
components, respectively. By maintaining centralized, accurate, and easily accessible
reference data, the data catalog ensures reliability, fosters interoperability, and enhances the
integrity of analytics and reporting processes.

Some examples of the catalog entities are Currency, and Country.

4.3 Catalog Extensions
Extension of data catalog is carried out with due consideration for Change Management
through an Issue-Action Management feature. Final step of Change Management includes a
built-in administrator level oversight for publishing the catalog changes into actionable
metadata as per a schedule that does not conflict with the data pipelines under execution. For
further information about how to browse and extend the Data Catalog, refer to the Oracle®
Data Foundation Cloud Service Data Platform guide.
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5
Data Controls

5.1 DQ Checks
Data Quality Framework consists of a scalable rule-based engine that uses a single-pass
integration process to standardize, match, and duplicate information across global data. This
framework within the infrastructure system facilitates you to define rules and execute them to
query, validate, and correct the transformed data existing in an Information Domain.

Data Catalog Contents include Data Quality Check Rules and DQ Groups (logical grouping of
DQ rules). These Rules are defined at the Business Term and Entity Level, and seeded as a
part of the Data Catalog Content.

For instructions on how to create/edit/delete DQ rule, refer to Oracle® Data Foundation Cloud
Service Data Platform.

The following is a list of pre-configured Data Quality rules included in the offering:

In the banking domain, data quality is essential for ensuring the integrity, accuracy, and
reliability of financial information that supports decision-making, compliance, and operational
efficiency. To maintain high standards of data quality, various validation rules are applied to the
data. These rules help identify and prevent errors, inconsistencies, and incomplete data entries
that could lead to incorrect business processes or regulatory violations. Common data quality
rules used in banking include Prebuilt Business check, list of values, referential integrity
checks, range checks, and more. Below is an overview of these rules, along with examples
specific to the banking domain, which highlight their importance in managing data effectively
across banking systems.

Data Quality Rules Definition Example Objective

Prebuilt Business
Checks

Prebuilt Business check
is a rule based on
business specific or
unique conditions that
don’t fall under standard
data quality rule
categories.

A customer's Account
Balance must not be
negative if the account
type is 'Savings'.

To apply business-
specific logic that isn't
captured by standard
validation rules.

List of Values or Code
Check

This rule ensures that a
field contains a value
from a predefined list of
valid values, such as
bank codes, account
types, or country codes.

The Account Type must
be one of the following:
'Checking', 'Savings',
'Credit".

To ensure only valid and
standardized data
entries are used in the
system.

Referential Integrity
Check

Ensures that
relationships between
different tables or data
entities are correct,
typically by checking
foreign keys against
primary keys.

The Loan ID in the
Payment History table
must exist in the Loan
Account table.

To prevent orphaned
records and ensure that
linked data entities are
consistent across the
system.
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Data Quality Rules Definition Example Objective

Column Reference or
Specific Value Check

Ensures that the value in
one column is consistent
with values in another
column or a related data
set.

If the Account Status is
'Closed', then the
AccountBalance must be
zero.

To ensure that business
logic between columns is
followed correctly.

Generic Check A general validation
check applied across
various data sets, such
as length checks or
format checks, which
doesn’t belong to a
specific category.

The IBAN number
should be 22 characters
long and contain only
alphanumeric
characters.

To apply basic checks
that are common across
different data sets.

NULL Value Check Verifies that required
fields are not missing,
meaning they are not
NULL.

The Customer Name
field must not be NULL
for all active customer
records.

To ensure that essential
customer or transaction
information is always
captured.

Range Check Verifies that data values
fall within a valid range,
which is commonly used
for numeric fields or
dates in banking
systems.

The Credit Score must
be between 300 and
850.

To ensure that data,
such as credit scores or
loan amounts, falls within
realistic and acceptable
ranges.

BLANK Value Check Ensures that fields do
not contain blank or
empty string values,
which may represent
missing or incomplete
data.

The Loan Amount field
must not be blank or
contain only spaces in a
loan application.

To prevent incomplete
data from being entered
into critical banking
systems, ensuring full
and valid records.

These banking-specific examples help ensure that critical financial data is correct, consistent,
and adheres to industry standards for data integrity and compliance.

In DFCS the following number of rules are bundled /autogenerated in each category.

Table 5-1    Number of Tools that are bundled

Check Type No of Rules

Prebuilt Business Checks 801

List of Values or Code Check 3266

Referential Integrity Check 7610

Column Reference or Specific Value Check 338

Generic Check 262

NULL Value Check 279

Range Check 11

BLANK Value Check 6

5.2 Balance Reconciliation
Balance Reconciliation reconciles the balances from the operational systems of a bank with
the balances maintained in General Ledger (GL) of the bank. The bank's operational data are
sourced into standard product processor entities or other operational data entities used by the
bank.
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The balances in the GL of a bank are the ones that are audited and duly certified by internal
and external auditors. Hence, considered to be the final version of the truth in a bank.
Therefore, all data extracted from any other operating system of a bank must be reconciled
with the balances maintained in the GL to ensure they are complete, accurate, and
comprehensive. It acts as an authentic and reliable base for any further decision-making.

DFCS' GL Reconciliation has pre-configured definition process. Currently DFCS supports
below type of reconciliation:

• General Ledger to Product Processor

Note:

For more information on Balance Reconciliation, see Balance Reconciliation in the 
Oracle® Financial Services Data Foundation Cloud Service for Banking Data
Controls user guide.
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6
Data Integration

Data Integration facilitates the exchange of data between the Data Foundation Cloud Service
and external systems through ADIs. External Data Descriptors (EDDs) are mapped to ADIs via
the user interface to form Connectors.

For more information, refer to the Oracle® Financial Services Data Foundation Cloud Service
for Banking Data Integration Guide.

6.1 File Operations
The file operation process enables you to add files that must be processed to the object store.
You can upload any CSV, XLSX, and Text file that you wish to be stored in the object store,
which can be processed later.

To upload a file, complete the following steps:

1. On the DFCS home page, click the User Menu and select Administration.

2. Click File Operations.

3. Click Upload File.

The Generate PAR URL to upload file window is displayed.

4. Enter the File Name.

5. Select the File Type from the drop-down list.

The supported file types are: CSV, XLSX, Text, and Zip.

6. Enter the file size (in bytes) as seen on the disk.

Note:

Enter a number between 0 and 8,053,063,681. The input should be no more than
255 characters. Ensure the value matches the following format: '[a-zA-Z0-9][a-
zA-Z0-9.-_:]*[a-zA-Z0-9]'.

7. Click Add to add more files, and repeat the steps.

8. Click Delete to remove files.

9. Click Generate.

This generates a PAR (pre-authenticated request) URL which is valid for 24 hours. This
PAR URL is used to upload the file into the object store.

10. An entry for the PAR URL you just created appears on the File Operations page.

The search feature provides you multiple options to search for a file based on name,
creation date, and so on. You can also sort the list by name and creation date in ascending
or descending order.
You can download a file using REST API.
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6.2 Background and Coverage
Data Foundation comes pre-configured with capabilities for assimilating data for the following
products. Assimilated data will act as single source of truth for all product related data. Data
Foundation also supports extensions of the underlying platform to support unique needs of the
customer not available in the pre-configured version.

While customers are expected to setup sourcing of data using EDDs, Data Foundation ships
with pre-built results area connectors for the following products.

• Annuity Contracts

• Bill Contracts

• Borrowings

• Cards

• Casa (Current/Checking Accounts, Savings Accounts)

• Commitment Contracts

• Commodity Contracts

• Correspondent Accounts

• Credit Derivatives

• Forwards Contracts

• Futures Contracts

• Foreign Exchange Contracts

• Investments

• Letter Of Credit Contracts

• Leases Contracts

• Loan Contracts

• Merchant Cards

• Overdraft Accounts

• Option Contracts

• Payment Settlement Accounts

• Prepaid Cards

• Repo Contracts

• Swaps Contracts

• Term Deposit Contracts

• Other Assets

• Custodial Accounts

• Trusts

• Trading Account

• Connectors for Islamic Banking products too are supported out-of-the-box.

– Ijarah Accounts
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– Istisna Accounts

– Mudarbah Accounts

– Murabahah Accounts

– Musharkah Accounts

– Salam Accounts

– Sukuk Accounts

6.3 Data Sourcing and Data Egress
Data Sourcing and Data Egress refer to the processes of acquiring data from both internal and
external systems (data sourcing) and transferring it to other environments or applications (data
egress). Data sourcing involves identifying, extracting, and collecting data from various
sources, such as transactional systems, third-party providers, or data warehouses. This data is
then processed and integrated to support business operations, reporting, or analytics. In
contrast, data egress deals with the movement of processed data from its original system or
database to other platforms, systems, or end-users. This may include sharing data with
downstream applications, regulatory reporting systems, or external partners. Both data
sourcing and egress must be carefully managed to ensure data quality, security, and
compliance with regulatory standards, particularly when handling sensitive financial or
customer information. Effective strategies for data sourcing and egress are vital to ensuring
that the right data is delivered to the right destinations in a timely, secure, and accurate
manner. In DFCS, data sourcing is facilitated through Ingress Connectors using External Data
Descriptors for each entity. For more details, see Data Integration Guide.
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7
Data Operations

Process Orchestration is a design and execution service that enables process pipeline
developers to implement pipelines modeled by business analysts. Process pipeline developers
use this framework to orchestrate Run Pipelines within DFCS, and also to design the artifacts
that are used in the pipelines.

The Process Modeller and the Process Monitor are two key parts of Process Orchestration.
The Process Modeller is used to model pipelines. It aids in representing the various artifacts
required for modeling and provides implementation details of the DFCS process artifacts. The
Process Monitor is used to monitor instantiated pipelines of DFCS.

DFCS supports orchestration of the Run Pipeline, which is any orchestrated pipeline consisting
of DFCS tasks and service calls that run within the DFCS context.

Note:

For more information on Run Pipeline, refer Run Pipeline.

7.1 Account Load Run Map Population
The Account Load Run Map Population process is a feature in Data Foundation Cloud Service
(DFCS) that manages and organizes the loading of intra-day accounts, particularly for
incremental and snapshot updates.

This section provides an overview of the operation process.

1. Intra-Day Accounts: Accounts are updated within a day based on specific activities or
events, and the system captures these changes efficiently.

2. Incremental and Snapshot Updates:

• Incremental Updates: Only the changes that have occurred since the last update are
captured (e.g., modifications or new records such as transactions or account status
changes).

• Snapshot Updates: A full view of the data at a specific point in time is captured,
including all account data, regardless of whether changes have occurred since the last
snapshot.

3. Load Run ID: Each account load (whether incremental or snapshot) generates a unique
Load Run ID. This ID is used to track, distinguish, audit, and ensure accurate tracing of
each load process.

4. Map Population: The loaded account data is mapped to a predefined structure or schema
within DFCS, ensuring it is correctly placed in the appropriate tables, formats, or structures
for further processing or reporting.
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7.1.1 Benefits
• Data Traceability: The Load Run ID provides an audit trail for each load operation,

ensuring traceability and transparency.

• Efficient Data Handling: The system can process intra-day account data efficiently by
only loading necessary changes with incremental updates while maintaining full data
integrity with snapshots.

• Consistency: The process ensures that the data is loaded into DFCS consistently and
accurately, making it ready for further downstream applications such as regulatory
reporting, analytics, and other business processes.

In essence, the Account Load Run Map Population process is key in handling dynamic,
intra-day account updates within DFCS, ensuring both data completeness (via snapshots) and
efficiency (via incremental updates).

7.2 Configuring Reporting Currency Attributes Before Executing
PMF

Pre-requisite:
Before executing Result Area Population PMF, you must configure the necessary settings to
ensure that the Reporting Currency Attributes in the Common Account Derived Attributes
Entity are populated with accurate conversion values. The Currency Exchange Module must
be executed before proceeding with this configuration.

1. Navigate to Administration → Click Run Execution Parameter.

Figure 7-1    Run Execution Parameter

2. Click Add Run Execution Parameter.
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Figure 7-2    Add Run Execution Parameter

3. Enter the following values in the popup screen:

• Parameter Name – Specify the execution parameter configuration name (required for
executing Result Area Population PMF).

• Description – Provide a brief description of the execution parameter configuration.

• Currency Rate Type – Select an appropriate value from the Currency Rate Type
Dimension.

• Currency Rate Nature – Select an appropriate value from the Currency Rate Nature
Dimension.

• Currency Rate Version – Choose a value from the Currency Rate Version
Dimension.

• Currency – Specify the target currency for conversion.

4. Click Save.

By completing this setup, the system will accurately derive and populate the Reporting
Currency Attributes for correct financial reporting.

7.2.1 Results Area Entities
Data Foundation has ability to provide data for analytical applications in finance, risk, and
compliance domains. It also has well-designed placeholders to store results data from these
applications.

Note:

Before proceeding with this configuration, ensure that the Currency Exchange
Module is executed. Refer to Configuring Reporting Currency Attributes Before
Executing PMF.

Key Features of the Results Area Design

• Design: The Reporting Area data model is a dimensional data model. This means that it
consists primarily of central fact tables (de-normalized), related to multiple dimension
tables, also called a Star Schema. Additionally, the dimension tables are shared across the
star schemas in the reporting mode, meaning they are Conformed Dimensions.
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• Support for multiple scenarios of analysis: The reporting data model has been
designed to support scenario analysis of the sort required by financial institutions that need
to measure and report risk and performance under a variety of economic scenarios. The
reporting model provides support for this kind of analysis via a Run Dimension – it allows
analytical engines to load multiple result sets identified by scenarios.

• Support for Cross Functional Reporting: The third critical feature of the Reporting area
design is the support for cross-functional reporting. Majority of emerging needs relate to
the analytical problems at the intersection of the distinct areas of Risk, Performance,
Customer Insight, and Compliance. This is addressed amply by the results area of Data
Foundation.

7.2.2 Results Area Load Batch
The Results Area Load Batch is a process in Data Foundation Cloud Service (DFCS) that
facilitates the loading of fact results from the staging results area into the final results area
for reporting purposes. This process ensures that the data is properly processed, organized,
and available for consumption by downstream reporting applications.

1. Loading Fact Results:

• Fact results are essentially the processed data that is typically used for reporting,
analytics, and business intelligence purposes.

• These facts could include various financial and transactional data points, such as
accounting entries, general ledger (GL) data, currency exchange rates, and so on.

• The data in the staging area may be raw, intermediate, or partially processed, and the
Results Area Load Batch is responsible for moving it into the final results area where
it is aggregated, cleansed, and made ready for reporting.

2. Run Surrogate Key:

• The Run Surrogate Key is a unique identifier that allows for tracking and managing
multiple load runs.

• Since data loads may occur multiple times a day, the surrogate key helps to
differentiate between different runs of the same type of fact data (e.g., accounting
entries or GL data). This ensures that even if the data loads are similar, each load can
be identified and handled independently.

• The surrogate key is important for data traceability, ensuring that each batch can be
traced back for auditing, version control, and historical analysis.

3. Examples of Fact Loads:

• Load Fact Accounting Entries: This process loads detailed accounting data, which
includes financial transactions that affect accounts, such as debits, credits, account
balances, and other related financial details.

• Load Fact GL Data: Loads general ledger data, which is aggregated and provides a
summarized view of financial transactions by categories such as account codes,
periods, and balances.

• Load Fact Currency Exchange Rates: Loads data regarding the exchange rates
between different currencies, which are essential for converting financial amounts into
consistent currency representations across different regions.

• Load Fact Accounting Entries Header: This is the header-level data associated with
accounting entries, which may include metadata such as transaction type, reference
numbers, and other summary information.
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7.2.2.1 Benefits
• Continuous Data Updates: By supporting multiple load runs per day, the system ensures

that the most up-to-date fact data is always available for reporting purposes.

• Efficient Tracking and Management: The use of a Run Surrogate Key.
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8
Data Visualizations

Data Foundation Cloud Service (DFCS) provides users with a powerful Data Visualization
feature to visualize loaded source data and processed results data directly via user interface.
The process of data visualization is very user friendly and does not require any query language
skills like SQL. Custom visualization report can be generated via direct drag and drop feature
and can further be used to analyze data insights effectively. This feature enables users to
explore and visualize data across the following key sections:

• Source data

• Results data

• Pre-Built reports and KPIs

• Data Quality dashboard

• General Ledger Reconciliation dashboard

• Custom attributes

• Data Visualization is available via the below path:

DFCS Main landing page -> View Data

8.1 Data Quality Visualizations
The Data Quality Visualization provides critical insights into data quality issues detected after
executing Data Quality (DQ) rules within the DFCS solution. The DFCS solution runs
predefined DQ rules and publishes the results in interactive dashboards. The dashboards
present a comprehensive view of error records associated with specific entities, helping users
identify data inconsistencies.

To access DQ dashboards:

Shared folders -> Data Quality Visualizations -> Data Quality

This section provides information on the Data Quality results for Data Visualization reports.

To access the Data Quality for Data Visualization Reports in DFCS, complete the following
steps:

• On the Home page, from the LHS menu, click Catalog.

• Under the Shared Folders tab, select Data Quality Visualization and then select data
Quality Reports to view the details of the Data Quality results.

• Data Quality Results for Data Visualization Reports page
You can navigate among the following canvases in the Data Visualization report:

– Data Quality Registry

– Data Quality Summary

– Data Quality Executions

– Data Quality Results
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Figure 8-1    Data Visualization report

Figure 8-2    Data Quality
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Figure 8-3    Data Quality Execution

Figure 8-4    Data Quality Results

8.1.1 Data Browser
The Data Browser provides users with access to visualize and explore raw data loaded into
staging entities after the data has been ingested. It helps users verify that the data matches
expectations.

• Source Data

• Results Data

• Pre-Built Reports

• Sample Key Performance Indicators (KPIs)
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8.1.1.1 Source Data
Source data visualization enables the user to view raw data loaded into staging entities post
data loading. This enables user to view the loaded data and ensure that it is as expected. Data
visualization is supported for pre-built datasets and is best suited for scenarios where a query
will return a few rows of the output.

Source Data Visualization is intended to provide authorized users tactical access to data that is
moved into DFCS Data Store. Such tactical access is used for verification purposes, primarily
in Test and Non-Production instances.

There are two ways to view source data:

1. Custom source data view

2. Pre-configured source data View

8.1.1.1.1 Custom Source Data View
User can create new visualization reports to view data for specific attributes that are not a part
of pre-configured staging data visualization.

User can create new visualization reports to view data for specific attributes that are not a part
of pre-configured staging data visualization.

Create (top right of screen) -> Workbook -> Datasets -> Search for relevant source entity.

• Navigate to Create on top right of the screen, select Workbook > Datasets > Search for
relevant entity.

Figure 8-5    Custom source data view
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Figure 8-6    Custom source data view 2

Figure 8-7    Custom source data view 3

8.1.1.1.2 Pre-configured source data View
User can view subset of staging data that is loaded from the source systems for a selected
pre-configured set of attributes. This is a restricted view that allows users to view only selected
attributes that hold the most commonly referred data. The benefit of having this restricted view
is faster data load and focused visualization of important data only. The solution also
aggregate queries with appropriate filters for use against any dataset.
Data Visualization provided with DFCS can be accessed via following navigation paths:

• Home -> Catalog -> Shared folders -> Data Foundation reports -> Source Data -> Banking
-> Subject Area -> Individual source entity.

Figure 8-8    Pre-configured source data view
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Figure 8-9    Pre-configured source data view 2

8.1.1.1.3 Exporting data
Data visualization (source data or results data) can be exported in various format like excel,
csv, PowerPoint and image.

Steps to export data:

1. Right click on Data -> Edit-> Copy -> Paste to excel.

2. Right click on Data -> Export -> File -> Chose format (PowerPoint, image, pdf or csv).

Figure 8-10    Party Financials
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Figure 8-11    Party Financials Export

Figure 8-12    Party Financials File

8.1.1.2 Results Data
DFCS supports result entities’ data visualization based on pre-defined out-of-the-box datasets
called subject areas. Each subject area is a pre-configured dataset that brings together all fact
entities of similar grain and includes pre-defined relationships with their related dimension
entities. Customized results data visualization canvases can be created by user to enable
them or other staff to access and analyze results data more as per their specific requirement
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for a given subject area. The service offering also includes pre-built sample dashboards called
Pre-Built reports for user to view results data.

Results Data visualization represents view of results (fact) data either via tables or via various
graphics forms such as charts, pie graphs, scatter plots and other such sophisticated forms.
Visualization can be for out-of-the box sample dashboards or custom requirements of user.
There are many visualizations options that help user display data in the form of tables or
various graphs and charts. Visualizations options include but are not limited to tabular data,
pivots, bar graphs (Vertical, horizontal, stacked bar, etc.) pie charts, line graphs, scatter
graphs, tree map, etc. This makes it easier for user to spot patterns and trends in massive data
sets that are hard to identify with the naked eye. These interactive dashboards can be created
by a business user to enable self and other staff to access information more easily, as data
visualizations created by one user can be shared with other users too. Each graphical element
has the potential to provide granular information that updates all visualizations in the
dashboard as the user drills down into finer and finer detail even on a single given
visualization.

To summarize, the main goal of results data visualization is to:

• Make results (fact) data available for user for each subject area or granularity.

• Make results (fact) data available for user for tabular view without the need to write
complex SQL queries or without any dependency on any third party application.

• Make results (fact) data available via graphic visualizations for data analysis and MIS
reporting.

• Access out of the box sample pre-built visualizations and pre-built reports for each subject
area.

• Access granular data via drill through.

• Share data visualizations custom created by one user with other users within the
organization.

• Access sample Key performance Indicators (KPIs).

• Options to export reports to multiple formats such as Microsoft Excel, Microsoft
PowerPoint, PDF, and so on.

Visualization options can be seen in LHS top under the Visualizations button.

Figure 8-13    Visualization

There are two ways to view results data:

1. Custom results data view

2. Pre-configured pre-built reports

Chapter 8
Data Quality Visualizations

8-8



8.1.1.2.1 Subject Area
A Subject Area (SA) is a pre-configured dataset that includes all fact entities (along with their
attributes) and their associated dimension entities, relevant to a specific functional domain.

Key Features:

• Domain-Specific Data Access – Provides users with a structured view of entities and
attributes needed for a particular functional area.

• Fact and Dimension Entities – Includes key data points (fact entities) and their contextual
details (dimension entities).

• Supports Multiple Granularities – Most Subject Areas contain entities of the same
granularity, but some may include multiple levels.

Example:

• The Accounts Subject Area allows users to access all account-granularity data,
including dimensions such as product type, party type, and account rating.

• While most entities follow the account grain, some may have different granularities, such
as account-rating or account-address grain.

For optimal data extraction, users should first review the Subject Area Granularity to
ensure they are working with the correct level of detail before extracting data.

8.1.1.2.2 List of subject areas supported
The subject areas will be enhanced in future releases to accommodate for more specific
granularities.

Below is the list of subject areas currently supported:

• Accounts

• Credit Line

• Data Quality Results

• Financial Accounting Entries

• Financial Ledger

• GL Reconciliation

• Party Details

Note:

Subject Areas come as part of out-of-the-box configuration and can’t be created
or modified by user. For any requirement related to subject area update, user will
need to raise a support request.

8.1.1.2.2.1 Subject Area Glossary

Each Subject Area has a pre-defined glossary that provides essential documentation for
users, helping them understand data structure and relationships.

• List of all result entities included in the subject area
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• Entity granularity of each result entity based on the primary keys

• Attribute name and detailed attribute description for all primary keys

• Entity relationships that define relation of attributes with related dimension entity and the
related attribute

The glossary helps users determine which attributes can be combined in a single visualization
for meaningful insights. A single visualization should include attributes of similar granularities to
avoid Cartesian join issues, which can lead to data misinterpretation.

For Example:

Attributes from Common Account Summary and Loan Account Summary can be used
together in a single visualization.

• End of Period Balance (EOP Bal) for loans should not be combined across Account
Rating Details and Common Account Summary.

• If an account has three credit ratings from different agencies, it will have three rows
for the same account, repeating the EOP Bal value.

• This could lead to the EOP Bal being aggregated incorrectly (e.g., tripled for a single
account).

Subject Area Glossary can be accessed as below:

• Home -> Catalog -> Shared folders -> Subject Area Glossary

Figure 8-14    Subject Area Glossary

8.1.1.2.3 Custom results data view
User can create new visualization reports to view data for specific attributes of results entities.
Steps to view custom source data in Data View UI are as below.

• Top Right Corner -> Create -> Workbook -> Subject Area -> Choose Subject Area -> (new
Workbook is created)

Chapter 8
Data Quality Visualizations

8-10



Figure 8-15    Custom results data view

Figure 8-16    Add Dataset
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Figure 8-17    New Workbook

Each workbook can have multiple Canvases, similar to the way excel workbook has
multiple sheets.
Each Canvas can have multiple visualizations, similar to the way single excel sheet can
have multiple graphs in single sheet. Maximum of 6 visualization is recommended in a
single canvas for optimum system performance.

User can drag and drop attributes required for analysis from left hand side (LHS) under
data button. This process is very user-friendly and doesn’t require the abilities of SQL
query writing to fetch data.

Figure 8-18    Data button

Attributes are displayed in data tab in following order:

• Fact entities in alphabetical order based on Entity logical name

• Dimension entities based on alphabetical order

• Attributes displayed in alphabetical order within fact and dimension entities

• ‘My Calculations’ on left bottom will display any calculation formulae added by user

Users can add calculation formula for value measures displayed in the view.

Users can also save and share these custom report created with other users.

8.1.1.2.4 Exporting Data
Data visualization (source data or results data) can be exported in various format like excel,
csv, PowerPoint and image.

Steps to export data:
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1. Right click on Data -> Edit-> Copy -> Paste to excel.

2. Right click on Data -> Export -> File -> Chose format (PowerPoint, image, pdf or csv).

Figure 8-19    Data visualization Party Financial Details

Figure 8-20    Data visualization Party Financial Details Export
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Figure 8-21    Data visualization Party Financial Details Export File

8.1.1.2.5 Sample Key Performance Indicators (KPIs)
Key Performance Indicators (KPIs) are pre-calculated values in the solution that measure
performance for a specific objective over time. KPIs provide measurable metrics for
businesses to track over time and gauge their progress. They also help with insights that help
FI business leaders to make data driven decisions, measure their performance and plan at a
strategic level.
Some sample KPIs are packaged in out-of-the box product and can’t be modified by the user.
However, user has the flexibility to create their own KPIs.

The solution aims to cover most indicators used across the banking and FI industry.

Currently, the solution supports Account based KPIs for Loans and Deposits.

To access these visualizations, navigate through the following path:

1. Home → Catalog → Shared Folders → Data Foundation Custom Reports à Key
Performance Indicators à Balance Sheet

The dashboard has a default set of filters as shown below and further filters can be added by
the user.
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Figure 8-22    Sample Key Performance Indicators (KPIs)

• To access these visualizations, navigate through the following path: Home → Catalog →
Shared Folders → Data Foundation Custom Reports à Key Performance Indicators à
Balance Sheet The dashboard has a default set of filters as shown below and further filters
can be added by the user.

8.1.1.2.5.1 Sample Loans and Deposits KPIs

KPIs related to Loans and Deposits KPIs are included as part of out of the box product. Users
can create their own KPIs and visualizations for that for their custom requirements.

Note:

This user guide does not explain individual visualization chart details, their calculation
logic and their interpretation as that is included as part of KPI glossary.

8.1.1.2.5.1.1 End of Period
This report presents a comparative analysis of Total Loans and Total Deposits as of specific
date, allowing users to examine the balance sheet dynamics and assess the relationship
between lending activities and deposit mobilization. Please refer to KPI Glossary in solution for
further details.

Users have options to choose values for pre-configured filter attributes or add their own filters.

Figure 8-23    End of Period

8.1.1.2.5.1.1.1 Time Series
This report gives a view into trend analysis of total outstanding loans, deposits and
investments over multiple time periods and how they have changed over time. It gives
breakdown of deposit types accepted and loan types floated in the market. It also shows

Chapter 8
Data Quality Visualizations

8-15



snapshot of Debt and Equity Investments over multiple time periods. Users have options to
choose values for pre-configured filter attributes or add their own filters.

Figure 8-24    Time Series

8.1.1.2.5.1.1.2 Deposit Growth
The Deposit Growth Visualization provides an insightful analysis of a financial institution's
deposit portfolio, focusing on key deposit categories of Current or check-in Account and
Savings Accounts and their movement over time periods. By offering detailed insights into
CASA ratio, total deposits, CASA deposits, and term deposits, users can effectively track and
analyze growth trends across different deposit categories.

Figure 8-25    Deposit Growth

8.1.1.2.5.1.1.2.1 Loans Growth
The Loans Growth Report offers a detailed analysis of loan, credit cards and overdraft
performance, highlighting both the total outstanding amounts and growth percentages for each
category. It enables users to evaluate lending trends across segments such as personal,
business, and auto loans, as well as credit card usage in retail and business domains.
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The charts display the total outstanding loan balances across all types of loans and their
corresponding growth percentages. It provides an overall view of the organization's lending
portfolio and its growth trends over time.

Figure 8-26    Loans Growth Report

8.1.1.2.5.1.1.2.2 KPI Glossary
All KPIs come with KPI Glossary that details below:

• KPI Name

• Description

• Calculation logic

• Logical Interpretation

KPI Glossary is made available by right clicking on any of the KPI visualizations as shown
below:

Figure 8-27    KPI Glossary
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Figure 8-28    KPI Glossary Report

8.1.1.2.5.1.1.2.3 Drill through for KPIs
Drill-down functionality enables user to view KPI data at the lowest granularity.

User starts pre-built report visualization from results (fact entities based) -> drill down to
more granular results (multiple levels of drill down in fact entities) -> View data at lowest
granularity.

Example:

Time Series report -> Education Loans KPI -> Country name drill down -> Party type (or party
name) drill down -> Account skey in fact common account summary -> Stage Loan Contracts

Figure 8-29    Drill through for KPIs

Hover over education loans as shown below to look at overall numbers:
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Figure 8-30    Balance Sheet KPIs

Right click and select Country name from drill down option as below:

Figure 8-31    Drill
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Figure 8-32    Drilldown at Country

Figure 8-33    Drill down to Party Name

Figure 8-34    Party Name Drill down
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Figure 8-35    Drill down for account level

Figure 8-36    Account drilldown

8.1.1.3 Pre-Built Reports
Most of the subject areas have a corresponding pre-built report for results data visualization.
Pre-Built reports have pre-configured tabular data and data visualization dashboards from the
entities within the subject area. You can view data for the pre-configured set of attributes in
these dashboards. You will have Read-only access to these reports as they are configured out-
of-the-box.

To access these reports, navigate through the following path:

1. Home → Catalog → Shared Folders → Data Foundation Reports.
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Figure 8-37    Catalog Shared Folders

Use Case Report: The use case reports serve as a download specification, helping you
identify the stage entities required for loading data into a specific Oracle Financial
Services application. Customers using multiple Oracle applications often need insights
into data reusability—determining whether data loaded for one application can be
leveraged for another. By providing this clarity, the specification enhances integration
efficiency, optimizes data management, and streamlines operations across Oracle’s
financial ecosystem.

a. Click Data Foundation Reports the list of reports is displayed.

Figure 8-38    Catalog Shared Folders Sample Reports

b. Click Sample Reports from the list.

Figure 8-39    Catalog Shared Pre-Built Reports
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The Right to Forget use case defines the process for identifying and deleting personal
data from Oracle Financial Services applications while ensuring compliance with privacy
regulations. It helps users manage data removal with minimal system impact, offering
clarity on data dependencies and compliance across multiple Oracle applications.

a. Click Data Foundation Reports the list of reports is displayed.

b. Click Right To Forget from the list.

c. Select Data Anonymization to view the reports. For more information, see Right To
Forget.

Figure 8-40    Right to Forget Reports

8.1.1.3.1 Navigation Path
To access these reports, navigate through the following path:

Home → Catalog → Shared Folders → Data Foundation Reports.

8.1.1.3.2 GL Summary
Financial Ledger pre-built report is based on subject area by the same name. It provides
stakeholders with an overall summary of institutions’ Chart of Accounts (CoA) as of the
selected date.

General Ledger Analysis and GL Account Distribution

The first two dashboards feature a series of donut visualizations that display the 5 main CoA
categories such as Assets, Expenses, Liabilities, Owner’s Equity, and Revenue. Each CoA
category has separate donut view for every currency where bank has exposure. The donut
shows breakdown for the CoA by the types of General Ledger (GL) data for each currency.

For example: For CoA of Assets, banks may have data spread across various currencies.
Donut will show view for Assets spread across their natural currencies by various GL types
(means asset types here) like Cash, Inventory, Fixed Assets, and so on.

First dashboard shows the data in local currency, whereas second dashboard shows data in
common accounting currency. Third dashboard shows data spread across various GL
Accounts for Budgeted Vs Actual Vs Forecasted numbers.
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Figure 8-41    General Ledger Analysis

Actual vs Budget vs Forecast

The Actual vs. Budget vs. Forecast visualization provides a view of budgeted GL numbers and
their comparison with actual numbers and forecasted numbers for future periods.

By visually depicting these differences, it enables banks to analyze the accuracy of their
budgeting and pinpoint areas of over- or under-budget spending, assess alignment with
financial goals, and refine future budgets to enhance accuracy and effectiveness in financial
planning. Forecasted numbers can give a view into future projections vs current numbers.

Figure 8-42    Actual vs Budget vs Forecast

8.1.1.3.3 Customer Account Summary
This pre-built report is based on Accounts subject area. It provides stakeholders with an overall
summary of credit status of institution's assets such as loans as of the selected date.

Credit Status: This provides a view of end-of-period balance in the reporting currency by
credit status across regions and branches. It enables stakeholders to assess the health of
credit portfolios and identify areas requiring attention. This helps in monitoring regional and
branch-level credit performance and risk exposure and helps identifying if any specific region
or branch needs attention.
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Figure 8-43    Credit Status

Non Performing Assets: Provides a visual representation of non performing assets (NPAs),
where definition of non performing asset is as per jurisdictional regulator and user provides
data marking accounts as NPA. This visualization is based on across regions using bar charts.
It offers insights into the distribution and health of non-performing assets (NPAs) by region.

Figure 8-44    Non Performing Assets

Branchwise NPA - This displays the distribution of non-performing assets (NPAs) across
branches for a particular region, segmented into various credit status categories such as
Bankrupt, Impaired, Written Off, and Delinquent. This chart provides a view of NPA
composition for each branch, enabling stakeholders to quickly assess and compare the extent
and type of financial risk across different branches of a given region. This is especially helpful if
user sees unexpected data for a given region in previous visualization, and wants to view data
spread across branches for that region.
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Figure 8-45    Branchwise NPA

8.1.1.3.4 Party Summary
This pre-built report is based on party subject area. It provides stakeholders with an overall
summary of parties to which bank has exposure. It gives view into parties and their related
parties, along with the financial exposure numbers like total assets vs liabilities outstanding
against all parties. It also gives view into parties’ risk profile analysis based on their credit
rating.

• Risk Profile Analysis: This visualization illustrates the risk profile of parties to which the
bank has credit exposure, based on their credit ratings as of the selected date. The bar
chart displays credit ratings along with the corresponding number of parties for each rating.
Users can filter the data based on Domestic vs. Foreign ratings and Rating Source
Code (Rating Agency) using the filter options provided at the top of the visualization.
Each rating source code is shown alongside the count of party identifiers, offering a clear
view of the risk rating distribution.

This visualization helps assess the overall risk landscape of institutional assets, such as
loans, enabling informed decision-making and effective risk management strategies.

The dashboard includes several default filters, such as Calendar Date, Purpose
Description for Domestic/Foreign Currency Ratings, and Rating Source Description,
allowing users to tailor their view based on specific preferences or requirements.

– Objective: To highlight the number of parties for each credit rating by a specific Credit
Agency and rating purpose.
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Figure 8-46    Risk Profile Analysis

• Party Financial Details: The visualization displays the total assets and liabilities of the
parties for the financial period as per selected Calendar date. Each party is listed with its
corresponding asset and liability amount, highlighting their financial position/obligation for
the selected calendar date. This analysis provides insights into the key contributors to the
organization's asset/liability base, aiding in performance assessment. This analysis also
facilitates insights into risk assessment and financial planning. User also has the option to
select specific party name from filter attribute on top and get view for a specific party.

– Objective – To highlight total amount of asset and liabilities against all parties or
specific party as of specific date

Figure 8-47    Party Financial Details

– Party Party Relationships and Party Party Account Relationship: Party relationship
visualizations provides a view of party relationships and their associated accounts
details. Relationship between related party and primary party could be personal like
spouse, parent, etc. of primary account holder or professional like CEO, Director of an
organization that is bank’s customer.

• Party Party Relationships:

– Objective – To highlight the relationship between different parties and relationship
effective date.
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Figure 8-48    Party Party Relationships

• Party Party Account Relationship:

– Objective – The dashboard gives view of party relationships and their associated
accounts.

Figure 8-49    Party Party Account Relationship

8.1.1.3.5 Credit Line Summary
This pre-built report is based on Credit Line subject area. It gives an overview.

• Credit Utilization by Parties: This bar graph illustrates total credit line against the utilized
amount, and helps bank quickly assess the overall credit utilization rate. This helps in
identifying trends over time, such as increases in credit usage which might indicate
economic stress among borrowers or a growing confidence and spending capability. The
visualization helps user analyze credit utilization numbers for each party and currency as
of date and analysis can be done at branch level.

– Objective – To highlight the total credit line and utilized amount for various parties
across different currencies as of given date for selected branch/branches.
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Figure 8-50    Credit Utilization by Parties

• Utilization Across Product Types: The visualization illustrates the total credit line
commitment amounts and the utilized amounts across different products denoted in
multiple currencies. This helps to analyze which products are most and least utilized,
banks can identify successful features or gaps in their offerings. This information can drive
the development of new products or adjustments to existing ones to better meet customer
needs.

– Objective – To highlight the total credit line amount and utilized amount by different
product types for selected branch/branches.

Figure 8-51    Utilization Across Product Types

• Credit Line Distribution: The Visualization provides insight into the predominant credit
line purposes at each branch allows a bank to tailor its products to better match local
demand. This helps management to assess the commitment track to aid in performance
review and Risk management.

– Objective – To view number of credit lines by credit line purpose for each branch
within the legal entity.
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Figure 8-52    Credit Line Distribution

• Credit Line Status: The dashboard illustrates the segregation of credit lines into various
credit status categories such as fully performing, delinquent and impaired. This helps
Banks to quickly identify areas of concern, particularly the proportion of non performing or
delinquent accounts. This allows for early intervention strategies to be deployed, such as
reaching out to customers who are falling behind on payments to offer restructuring or
support services that might prevent further delinquencies.

• Activity - Results Data Browsing

– Objective – To view number of credit lines by credit line status like fully performing,
delinquent, impaired for each branch within the legal entity.

Figure 8-53    Credit Line Status

• Participation and Volume Analysis: The visualizations show the participation flag for
credit lines alongside the sum of total credit line amounts tagged with that flag which helps
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banks in analyzing how participation in specific credit programs impacts their overall credit
portfolio. Participation flag indicates if the credit line facility is a part of the syndication.

– Objective – To highlight the total credit line amounts and Participation counts by Legal
entity and Calendar date.

Figure 8-54    Participation and Volume Analysis

8.1.1.3.6 Drill through option
Drill-down functionality enables user to view data at the lowest granularity. The lowest
granularity level at which the user is able to drill is specific to a given subject area (SA) on
which visualization is based and attributes present in that subject area. For example: In
Account subject area, the lowest level granularity would be accounts (account key in fact
entities and account identifier in stage entities). Similarly for transaction subject area, lowest
level granularity available for viewing via drill through will be transaction identifier.

The solution currently supports drill-through up to data in results entities, and not for stage
entities.
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Functionality is available for all pre-built reports for attributes that are contributing towards data
for that pre-built report. Drill through can be done for all types of visualizations including but not
limited to tabular, pivots, graphical, pie charts, time series, and so on.

Data viewed post drill-through pre-applies all the filters and shows user the specific granular
data that user was viewing before drill through.

1. Go to chart where user needs to see specific data -> Right click -> Drill to attribute/
Hierarchy -> Select specific hierarchy for which user wants to view data.

Figure 8-55    Drill through option
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Figure 8-56    Drill through option Data Elements

8.1.1.4 Sample Key Performance Indicators (KPIs)
Key Performance Indicators (KPIs) are pre-calculated values in the solution that measure
performance for a specific objective over time. KPIs provide measurable metrics for
businesses to track over time and gauge their progress. They also help with insights that help
FI business leaders to make data driven decisions, measure their performance and plan at a
strategic level.
Some sample KPIs are packaged in out-of-the box product and can’t be modified by the user.
However, user has the flexibility to create their own KPIs.

The solution aims to cover most indicators used across the banking and FI industry.

Currently, the solution supports Account based KPIs for Loans and Deposits.

To access these visualizations, navigate through the following path:

1. Home → Catalog → Shared Folders → Data Foundation Custom Reports à Key
Performance Indicators à Balance Sheet

The dashboard has a default set of filters as shown below and further filters can be added by
the user.
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Figure 8-57    Sample Key Performance Indicators (KPIs)

• To access these visualizations, navigate through the following path: Home → Catalog →
Shared Folders → Data Foundation Custom Reports à Key Performance Indicators à
Balance Sheet The dashboard has a default set of filters as shown below and further filters
can be added by the user.

8.1.1.4.1 Sample Loans and Deposits KPIs
KPIs related to Loans and Deposits KPIs are included as part of out of the box product. Users
can create their own KPIs and visualizations for that for their custom requirements.

Note:

This user guide does not explain individual visualization chart details, their calculation
logic and their interpretation as that is included as part of KPI glossary.

8.1.1.4.1.1 End of Period

This report presents a comparative analysis of Total Loans and Total Deposits as of specific
date, allowing users to examine the balance sheet dynamics and assess the relationship
between lending activities and deposit mobilization. Please refer to KPI Glossary in solution for
further details.

Users have options to choose values for pre-configured filter attributes or add their own filters.

Figure 8-58    End of Period

8.1.1.4.1.2 Time Series

This report gives a view into trend analysis of total outstanding loans, deposits and
investments over multiple time periods and how they have changed over time. It gives
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breakdown of deposit types accepted and loan types floated in the market. It also shows
snapshot of Debt and Equity Investments over multiple time periods. Users have options to
choose values for pre-configured filter attributes or add their own filters.

Figure 8-59    Time Series

8.1.1.4.1.3 Deposit Growth

The Deposit Growth Visualization provides an insightful analysis of a financial institution's
deposit portfolio, focusing on key deposit categories of Current or check-in Account and
Savings Accounts and their movement over time periods. By offering detailed insights into
CASA ratio, total deposits, CASA deposits, and term deposits, users can effectively track and
analyze growth trends across different deposit categories.

Figure 8-60    Deposit Growth

8.1.1.4.1.4 Loans Growth

The Loans Growth Report offers a detailed analysis of loan, credit cards and overdraft
performance, highlighting both the total outstanding amounts and growth percentages for each
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category. It enables users to evaluate lending trends across segments such as personal,
business, and auto loans, as well as credit card usage in retail and business domains.

The charts display the total outstanding loan balances across all types of loans and their
corresponding growth percentages. It provides an overall view of the organization's lending
portfolio and its growth trends over time.

Figure 8-61    Loans Growth Report

8.1.1.4.1.5 KPI Glossary

All KPIs come with KPI Glossary that details below:

• KPI Name

• Description

• Calculation logic

• Logical Interpretation

KPI Glossary is made available by right clicking on any of the KPI visualizations as shown
below:
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Figure 8-62    KPI Glossary

Figure 8-63    KPI Glossary Report

8.1.1.4.1.6 Drill through for KPIs

Drill-down functionality enables user to view KPI data at the lowest granularity.

User starts pre-built report visualization from results (fact entities based) -> drill down to
more granular results (multiple levels of drill down in fact entities) -> View data at lowest
granularity.

Example:

Time Series report -> Education Loans KPI -> Country name drill down -> Party type (or party
name) drill down -> Account skey in fact common account summary -> Stage Loan Contracts
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Figure 8-64    Drill through for KPIs

Hover over education loans as shown below to look at overall numbers:

Figure 8-65    Balance Sheet KPIs

Right click and select Country name from drill down option as below:
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Figure 8-66    Drill

Figure 8-67    Drilldown at Country
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Figure 8-68    Drill down to Party Name

Figure 8-69    Party Name Drill down
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Figure 8-70    Drill down for account level

Figure 8-71    Account drilldown

8.2 Use Case Analysis
The Use Case Analysis report is part of the Data Foundation Reports repository within the
Catalog system. It serves as a structured analysis tool for understanding different business use
cases, entities, attributes, and related business terms. This report is essential for organizations
that need insights into various data use cases and their associated metadata.

To access DQ dashboards:

1. Navigate to Data Visualization, click Source Data Visualization.

2. Navigate to the Catalog menu, and open the Catalog application.

3. Click on the Shared Folders tab.

4. Navigate to Data Foundation Reports.
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5. Locate the Use Case Analysis folder in the list and click Use Case Analysis.

6. Inside the folder, open the Use Case Analysis report.

The Use Case Analysis > Visualize window appears.

Figure 8-72    Visualize Window

Use Case Analysis Window
The Use Case Analysis window consists of several key elements that help users explore and
visualize data effectively. Here’s a breakdown of the main items available in the Use Case
Analysis window:

• On the Visualize window, the following canvas are available in the Use Case Analysis
report:

– Summary – Overview of all use cases and attributes.

– Use Case Details – In-depth details for each use case.

– Use Case Comparison – Side-by-side comparison of use cases.

– Attribute Details – Breakdown of attributes within each use case.

The left pane consists of the following options:
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Figure 8-73    Left Navigation Pane

• Data: Lists the data attributes such as Use Case ID, Name, Entity details, Grain details,
Attribute details and Download Type

Note:

Click on Add to add Dataset, create Scenario, and Add Calculations.

.

• Visualization: Includes tiles, charts, and tables to facilitate data exploration, trend
analysis, and issue resolution. It displays the following key metrics:

– Number of Use Cases (e.g., 9)

– Number of Entities (e.g., 209)

– Number of Business Terms (e.g., 2,058)

– Number of Attributes (e.g., 5,380)

– Additional charts and insights include:

* Number of Attributes by Use Case – a word cloud representation highlighting
key areas such as Profitability Management, Liquidity Risk Management,
Balance Sheet Planning, and Funds Transfer Pricing.

* Number of Attributes by Grain – a bar chart showing attribute distribution
across different grains.
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• Analytics: Enables users to drill down into specific entities, understanding the nature and
scope of data inconsistencies.

Note:

You can search for relevant options from the search box.

Summary
The Summary section provides an overview of how to use the tool effectively, including how to
assess additional elements required for integration with other financial products.

Figure 8-74    Summary Window

• Determine the impact of additional financial products.

• Identify missing elements needed for full integration.

• Understand table relationships between different applications.

• Percentage-Wise Requirement AnalysisIdentifies percentage gaps (e.g., a customer needs
to bring in the remaining 25%).

• Helps determine which additional datasets, calculations, or reports are necessary for
complete functionality.

• Balance Sheet & Customer Data IntegrationEvaluates which balance sheet elements must
be incorporated.

• Assesses customer data integration requirements for analytics and compliance.

Chapter 8
Use Case Analysis

8-44



Use Case Details
The Use Case Details section provides an overview on how to analyze entity usage across
various use cases in financial or business management.

Figure 8-75    Use Case Details

• Check the percentage indicator to see what portion of the required data is already
available.

• Review the missing components and determine what additional elements must be
integrated.

Use Case Comparison
This section provides an overview on how to compare attributes across different financial/
business use cases. It displays percentage coverage of attributes between the reference use
case and comparative use case.
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Figure 8-76    Use Case Comparison

• Reference Use Case: Acts as a benchmark for evaluating other use cases.

• Comparative Use Case: The use case that is directly compared to the Reference Use
Case.

• Number of Common Attributes: The count of shared Entity.Attributes between the
Reference and Comparative Use Cases.

• Number of Additional Attributes Required: The count of extra Entity.Attributes needed
for the Comparative Use Case that are not included in the Reference Use Case.

• % of Comparative Use Case Attributes Available in Reference: The percentage of
attributes from the Comparative Use Case that are present in the Reference Use Case.

Example

The pop-up tooltip (hovered over any entity) provides:

• Number of attributes in the Reference Use Case (1,210).

• Number of attributes in the Comparative Use Case (1,881).

• Number of Common Attributes (194).

• Number of Additional Attributes Required (1,687).

• Percentage of Comparative Use Case Attributes available in the Reference Use Case
(10%).

• Insights:

– High percentages (green areas) indicate a strong overlap of attributes between
reference and comparative use cases.

– Low percentages (red areas) suggest gaps or differences between the datasets.

– Some cells show 100% coverage (e.g., "Funds Transfer Pricing"), meaning the
attributes completely match between the two use cases.
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Attribute Details
Attributes Details report within a Use Case Analysis dashboard is structured as a data table
showing attributes related to financial or business processes.

Figure 8-77    Attribute Details

The interface consists of two main sections:

Data Table (Attributes Details) – Displays key dataset details:

• Use Case – Business process or scenario

• Grain – Level of data detail

• Entity – Business data objects

• Attribute – Specific data fields (e.g., "Account or Contract Number")

• Usage Type – Classification of attributes (e.g., "Mandatory" means required)

8.3 Right To Forget
The Right to be Forgotten (RTF) feature ensures that businesses protect sensitive Personally
Identifiable Information (PII) related to party data. This functionality is available in Data
Foundation Cloud Service (DFCS) and involves randomizing party data when it is no longer
needed in the system.

RTF Process Overview

• The RTF process is executed as a PMF job.

• It is user-driven, requiring customers to input Party Identifiers that need to be forgotten.

• Users must provide Party Identifiers through a PMF input, with multiple IDs entered as
comma-separated values.
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• Before executing the RTF process, users must invoke the SCD process (DIM Incremental
Process) to update the Party Dimension.

• Only Party IDs present in the Party Dimension will be considered for randomization.

RTF Execution Details

• For each RTF request, the service checks if the user has sensitive PII-related party data
in any entity.

• If such data exists, the system fetches the list of affected entities and randomizes the PII-
related data.

• The RTF Metadata Registration Table is preconfigured with Party Identifier (Business
Term - BTO3899) for executing the RTF functionality.

RTF Data Visualization Reports

The following RTF-related information can be viewed in Data Visualization (DV) reports:

1. Navigate to the Catalog menu, and open the Catalog application.

2. Click on the Shared Folders tab.

3. Navigate to Data Foundation Reports.

4. Locate the Right To Forget folder in the list and click Sensitive Data Anonymization. For
more information, see Pre-Built Reports.

Figure 8-78    Data Visualization

5. Dashboard Sections:

• Customer Request and Status – Displays request details.

• Audit Log – Tracks affected records for accountability.

6. RTF Customer Request Table – Stores details of each RTF request, including:

• Request Identifier – Unique request number.

• Requested Date – Date of submission.

• Requested By – Username of requester.
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• Party Identifier – Entity involved.

• Execution Status – Indicates success or failure.

7. Reviewing the Audit Log:

• Party Identifier – Matches request ID.

• Entity Name – Type of entity affected.

• Records Affected – Number of modified records.

8. Filtering and Searching Requests:

• Use filters (e.g., Date, Requested By, Status) to narrow results.

• Select a request to view details in the Audit Log.

9. Verifying Execution Status & Impact:

• If successful, check affected records.

• If failed, troubleshoot using system logs.

10. RTF Execution Status – Once the RTF Engine PMF process completes, the system logs
the execution status:

• If the Party ID is not found, the system updates the status as Not Available and exits.

11. RTF Audit Log – Maintains execution records at the Entity Level, including:

• Date of execution

• Number of records affected

Post-Execution Considerations

• Once an RTF request is successfully processed, the party data is randomized and
secured.

• To maintain data integrity, users must ensure that the forgotten Party IDs do not re-enter
the system during data loads from multiple sources into DFCS.

To navigate to the DFCS Right to Forget, follow the below steps:

1. Navigate to the Data Foundation for Banking home page.

Figure 8-79    DFCS RTF UI flow– Home Page

2. Click on Data Pipelines under the Data Integration section. The Process Modeller
window will appear.
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Figure 8-80    Process Modeller - Right to Forget

3. In the Process Modeller search box, enter Right to Forget. Alternatively, scroll down to
locate the process manually.

Figure 8-81    RTF - Search

4. Ensure that the Pipeline Filters are listed.

5. Click Search to proceed or Cancel to modify the details.

6. The Right to Forget process name will appear in the results.

Figure 8-82    Right To Forget - Search Result
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7. On the Right To Forget window, the following options are available:

• Launch Process in New Window

• Version (Displays the process version)

• Instances (Shows active instances)

• Application Type (Displays application details)

• Modification Details (View last modified details)

• Delete (Remove the process)

• View (Check process details)

• Copy (Duplicate the process)

• Process Flow Monitor (Track execution flow)

• Execute Run (Run the process)

• Filter (Refine search results)

8. In the Right to Forget window, locate and click on the Execute Run option.

Figure 8-83    Execute Run

9. Choose one of the following execution types:

• Without Parameters – Runs the process without requiring additional inputs.

• With Parameter – Requires user-specified inputs before execution.

10. If executing With Parameter, enter the Object ID in the designated input field.

11. Click on the Execute button to start the process.

12. Track the execution progress in the Process Flow Monitor.
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Figure 8-84    Process Flow Monitor

13. Check logs for status updates and any potential errors.

14. Click on the ellipsis (⋮) button next to the running process.

Figure 8-85    Modify Execute Run

15. Choose an Action:

• Resume – Continue a paused or failed execution.

• Re-Run – Restart the process execution from the beginning.

• Abort – Stop the execution immediately if necessary.

16. Confirm Action (if prompted): Depending on the action chosen, you may need to confirm
before proceeding.

8.4 Balance Reconciliation Visualizations
The GL Reconciliation process ensures that balances from a bank's operational systems
(typically standard product processor entities) are reconciled with the General Ledger (GL)
balances.

GL Reconciliation Visualizations: The dashboards provide insights into reconciliation
differences detected after executing the reconciliation process. Key components include:

• Reconciliation Differences – Highlights discrepancies between operational balances and
GL balances.
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• Threshold Breach Summary – Identifies instances where reconciliation variances exceed
predefined thresholds.

• Adjustments Summary – Displays adjustments made to correct discrepancies.

Steps to Access GL Reconciliation in DFCS:

1. On the Home page, navigate to the LHS (Left-Hand Side) menu and click Catalog.

2. Under the Shared Folders tab, select Reconciliation Framework.

3. Click on Dashboards to view GL reconciliation results.

Accessing GL Reconciliation Dashboards

To view the GL Reconciliation Dashboards, follow these steps:

1. Navigate to Shared Folders.

2. Select Reconciliation Framework.

3. Click on Dashboards to access the reconciliation results.

GL Reconciliation Results – Data Visualization Reports:

Within the Data Visualization Reports, users can navigate through the following canvases:

• Home – Overview of reconciliation results.

• Threshold Breach – Displays instances where reconciliation variances exceed predefined
limits.

• Map Filter Report – Provides a detailed view of reconciliation mappings and applied
filters.

Figure 8-86    Access GL Reconciliation in DFCS

For further details on using dashboards, refer to the Data Controls User Guide.

8.5 Custom Attributes
Catalog extension – it is not update the OBIEE catalog automatically.

User should add equal number of attributes for the respective entities being extended and map
the same individually as per the changes in the catalog.
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DFCS supports Custom Attributes in out of the box dimensions for Accounts Subject Area.
Users can use the Reporting Configuration window to map the Custom Attributes in OOB
dimensions.

8.5.1 Custom Attributes creation
To define a custom attribute in OOB table, complete the following steps:

1. On the DFCS Home page, click the My Profile icon and select Administration.

2. Click Report Configuration.

3. Select the OOB table and click on the Edit icon.

4. Select the attribute based on data type needed like date, numeric or string.

5. Click on the Edit icon in the Attribute mapping window.

6. Select the Attribute name from the dropdown list and click Save.

7. To delete a custom attribute, select the attribute and click on Delete icon.

Figure 8-87    Custom Attributes creation

Chapter 8
Custom Attributes

8-54



Figure 8-88    Report Configuration

Figure 8-89    Report Configuration Dimension Mapping

Figure 8-90    Attribute Mapping

Note:

User cannot Edit or Delete the OOTB dimension, it will display NA flag in the
Dimension Mapping window. The available and mapped flag for Custom
Attributes are displayed in the Attribute Mapping window to show the availability
of attributes.
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Following are the number of custom attributes by data type that can be defined for existing
OOB entities supported in the current release for Accounts subject area:

PRESENTATION
ENTITY NAME

NUMERIC STRING DATE

Organization Unit 55 110 5

General Ledger Account 55 110 5

Product 20 20 5

Legal Entity 20 20 5

Branch 20 20 5

Business Unit 20 20 5

Account 10 41 8

Location 20 20 5

Account Summary 30 10 10

8.5.2 Custom Attributes Visualization
In order to view the extended custom attributes in a staging table and view their logical names,
user can create a Dataset and generate reports in the Data Visualization using OAS interface
using Create Dataset Option available on top right.

To create a dataset and view the custom attributes in staging tables in the Data Visualization
canvas in DFCS, complete the following steps:

1. On the Home page, click the Create icon and then click Dataset.

2. The Dataset page is displayed.

a. Click Create and select Dataset from the available list.

The Create Dataset window is displayed with the list of available connections.

a. Double click on the DS Connection and the New Dataset page is displayed.

b. From the LHS menu, double click on the Manual Query, the Manual Query button is
displayed.

c. Double click on the Manual Query button, and enter the SQL query under the
Statement window.

d. Click Get Preview Data to preview the data of the entered query.

e. Click Save and the Save Dataset As window is displayed.

f. Enter the Name and Description of the dataset and click OK.

You can view the list of extended columns in the staging table.
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Figure 8-91    Custom Attributes Visualization

Figure 8-92    Create Dataset

Figure 8-93    New Dataset
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9
Change Management

Users can resolve any data issue identified in the Cloud framework by creating Issues and
appropriate Actions on the Inbox page. Data Issues such as Data Quality failures, Variance
breaches, or even known issues can be fixed using the Adjustment Framework option in
Action. The adjustment entries posted are audit trailed and data traceability enabled.

For further details on how to use feature of Issues and Actions, please refer to Oracle® Data
Foundation Cloud Service Data Platform.
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Issues and Actions

You can resolve any data issue identified in the Cloud framework by creating Issues and
appropriate Actions on the Inbox page. Data Issues such as Data Quality failures, Variance
breaches, or even known issues can be fixed using the Adjustment Framework option in
Action. The adjustment entries posted are audit trailed and data traceability enabled.

For more information, refer to the Oracle® Data Foundation Cloud Service Data Platform
guide.
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Key Terms and FAQs

• Adjustment Entry
An entry passed in the Product Processor (PP) to reconcile it with the associated GL for
the amount equivalent to the difference and an entry in the Contra GL Account with the
opposite sign for the same amount.

• Adjustment Entry Floor
If the difference between Source and Target is less than the Adjustment Entry Floor
specified in the definition, the calculated difference is not eligible for adjustment, and the
entry will not be logged in the Adjustment Entry Table.

• Attributed Dimension
A dimension whose members can have other properties or qualifiers known as Dimension
Attributes.

• Dataset
A dimension used for segregating data into different sets according to its use or its source.
For example, to separate actuals data, budget data, and encumbrances data. Other uses
include separating test data from production data and creating separate data sets for
What-if Analysis.

• Dimension
A structure that can be used to categorize business data. A dimension contains members;
it can be hierarchical (you can organize the members into one or more hierarchies), or
non- hierarchical.

• Dimension Attributes
A property or qualifier that further describes a dimension member. An attribute can be a
date, a number, or a character string. For example, the Geography dimension can have an
attribute - Population, that designates how many people live in that area. Each member of
the Geography dimension, therefore, has an associated Population.

• Hierarchy
A structure of dimension members organized by parent-child relationships.

• Global Threshold
Global Threshold is applied at an execution level where all the reconciliation differences for
execution are added and checked across the absolute sum of source balance.

• Inherit to Child
This feature is used to find child legal entities under the hierarchy node of a Legal Entity
that is selected at the definition level. If used while defining the GL Reconciliation rule, all
child nodes will participate in the reconciliation process.

• Reconciliation
Reconciliation is the process of comparing information from one data source to another. An
Account Reconciliation is for a specific period. Reconciliations consist of account balances
(obtained from the Source System for the period) and account properties.

• Reconciliation Difference
Reconciliation difference is the difference in the balance between the Source and the
Target.

• Threshold
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A tolerance level you must set in terms of either the maximum difference allowed in any
single Product Processor and its corresponding GL or the maximum number of Product
Processors having differences in the GL Reconciliation.

• Positive Threshold
These values are used to identify the breach types categorized as: Negative Percentage
Threshold (NPT), Positive Percentage Threshold (PPT), Negative Absolute Threshold
(NAT), Positive Absolute Threshold (PAT), and Not Breached (NB). The Breach Type is
identified at run time during the reconciliation process, and Audit Trail entries are posted
with this information.

• Negative Threshold
These values are used to identify the breach types categorized as: Negative Percentage
Threshold (NPT), Positive Percentage Threshold (PPT), Negative Absolute Threshold
(NAT), Positive Absolute Threshold (PAT), and Not Breached (NB). The Breach Type is
identified at runtime during the reconciliation process, and Audit Trail entries are posted
with this information.

• Threshold Breached Type
The different types of threshold breaches are listed here.

– PAT - Positive Absolute Threshold

– NAT - Negative Absolute Threshold

– PPT - Positive Percentage Threshold

– NPT - Negative Percentage Threshold

– G - Global

– NB - Notbreached

• General Ledger to Product Processor
General Ledger to Product Processor Reconciliation identifies the difference between GL
system and Product Processor data. It nullifies the difference by posting the adjustment
entries up to the amount of difference.

• General Ledger to Product Management Ledger
In General Ledger to Management Ledger (GL to ML) reconciliation, the difference
between two sources of the Ledger for the same Legal Entity and the Consolidation Type
is identified. This difference is identified at the granularity of the GL code for the selected
hierarchy, the mandatory dimensions, and the selected optional dimensions. Adjustments
are not passed in General Ledger to Management Ledger reconciliation.

• Consolidation Type
Two consolidation types are supported:

– Solo
When a legal entity is selected with consolidation type as Solo, all the exposures of
that particular legal entity are selected for processing. Manual reconciliation definition
can process solo legal entity data.

– Consolidated
When a parent legal entity is selected as Consolidated, all the exposures of that legal
entity and exposure of each level (or levels) of descendant child legal entities (without
intra-group exposures) are selected for processing. In intra-group exposures, the
counterparty is a child descendant of any level. For an intra-group scenario (where the
GL Structure has specific intra-group GL Code in addition to regular GL Codes), intra
GL Codes are considered only from the GL side for processing. Non-Intra is a scenario
where no GL Codes are present for reconciliation definition.

– Inherit to Child
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This feature is used to find child legal entities under the hierarchy node of a Legal
Entity that is selected at the definition level. If used when defining the GL
Reconciliation rule, all child nodes will participate in the Reconciliation Process.

– Manual Reconciliation Definition
In manual reconciliation definition, user input is sought on the GL side and PP side to
determine the course of reconciliation. This is applicable to both GL level and map
level reconciliation. In GL level reconciliation, unique GL codes are identified from the
GL code mapping. At the map level, GL codes do not form a part of the reconciliation
definition. A manual reconciliation definition can be used for a solo or consolidated
legal entity. The reconciliation definition for a consolidated GL, having an intra-group
GL structure, is computed from GL Data and not from PP Data. Therefore, any
account present in the PP but unavailable in GL is not captured in the reconciliation
definition.

– GL Level Reconciliation
In GL level reconciliation, the difference between GL system and Product Processors
Systems at each reconciliation dimension node level within a GL Code is identified.
For manual reconciliation definition, unique GL codes are identified from the GL side. If
it is at the solo level, exposures originating in the legal entity are selected. If it is at the
consolidated level, exposures originating in the selected legal entity and its Child
Entities (with or without intra- group exposures depending on GL Structure) are
selected.

The adjustment entry allocation depends on the reconciliation type selected. In GL
level reconciliation, after a definition is executed, the differences that emerge as a part
of the reconciliation definition (GL–PP level reconciliation) are reported in the
Adjustment Entry Table. This table shows all the entries of an executed map that
requires adjustment. The difference in amount can either be posted to Product
Processors or an external table. For more information on the external table, see the
Data Requirement section.

– Map Level Reconciliation
In map level reconciliation, the difference between GL Data and PP Data at each
reconciliation dimension node level across all PPs is identified. Unlike GL level
reconciliation, map level reconciliation is computed at an aggregate level of the
reconciliation definition; by ignoring the GL code and by considering reconciliation
dimensions. Map level reconciliation is applied at the legal entity level - either solo or
consolidated. If it is at the solo level, then exposures originating in a particular legal
entity are selected. If it is at the consolidated level, then exposures originating in the
selected legal entity and its child entities (excluding intra-group exposure depending
on GL structure) are selected.

The adjustment entry allocation depends on the reconciliation type selected. In map
level reconciliation, after a definition has been executed the differences that emerge as
a part of the reconciliation (General Ledger–Product Processor Level Reconciliation)
are reported in the Adjustment Entry Table. This table shows all the entries of an
executed map that requires adjustment. The difference in amount can either be posted
to Product Processors or an external table. The adjustment allocation can be either
automatic or manual.

11.1 Frequently Asked Questions
You can refer to the Frequently Asked Questions, which is developed with the interest to help
you resolve some of the DFCS Installation and Configuration Issues. This intends to share the
knowledge of problem resolution to a few of the Known Issues. This is not an official support
document and just attempts to share the knowledge of problem resolution to a few of the
Known Issues.
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1. What happens when users try to log in during a maintenance period?
When the instance is under maintenance, a “Maintenance Page” is displayed.

2. What happens for the users that are logged in?
If users are already logged in, all further actions are blocked. On refresh, users are
directed to the Maintenance Page.

3. Can APIs be invoked during maintenance period? No. The API requests are blocked.
No. The API requests are blocked.

4. What happens to ongoing batches?
Batches will continue, however, it is recommended to ensure all processes are completed
before maintenance begins.
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